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Abstract

Prions are unconventional self-propagating proteinaceous particles, devoid of any coding nucleic acid. These proteinaceous seeds serve as
templates for the conversion and replication of their benign cellular isoform. Accumulating evidence suggests that many protein aggregates
can act as self-propagating templates and corrupt the folding of cognate proteins. Although aggregates can be functional under certain
circumstances, this process often leads to the disruption of the cellular protein homeostasis (proteostasis), eventually leading to devastating
diseases such as Alzheimer’s disease (AD), Parkinson’s disease (PD), Amyotrophic lateral sclerosis (ALS), or transmissible spongiform
encephalopathies (TSEs). The exact mechanisms of prion propagation and cell-to-cell spreading of protein aggregates are still subjects of
intense investigation. To further this knowledge, recently a new metazoan model in Caenorhabditis elegans, for expression of the prion domain
of the cytosolic yeast prion protein Sup35 has been established. This prion model offers several advantages, as it allows direct monitoring of the
fluorescently tagged prion domain in living animals and ease of genetic approaches. Described here are methods to study prion-like behavior of
protein aggregates and to identify modifiers of prion-induced toxicity using C. elegans.

Video Link

The video component of this article can be found at http://www.jove.com/video/52321/

Introduction

Many neurodegenerative diseases, including Alzheimer’s disease (AD), Parkinson’s disease (PD), Amyotrophic lateral sclerosis (ALS), and
transmissible spongiform encephalopathies (TSEs), are associated with aggregation-prone proteins and are hence collectively known as protein
misfolding disorders (PMDs). TSEs or prion diseases constitute a unique class of PMDs in that they can be infectious in both humans and
animals1. At the molecular level, prions replicate by recruiting and converting monomeric α-helix-rich host-encoded cellular PrP (PrPC) into the
pathological β-sheet-rich PrPSc conformation2,3. Self-propagating protein aggregates have been also identified in fungi, which share important
characteristics with mammalian prions4,5. Additionally, mammalian prions are capable of moving from cell-to-cell and infect naïve cells6,7.

While PMDs other than TSEs are not infectious, they share a common pathogenic principle with prion diseases8,9. Although the proteins linked
to each of the PMDs are not related in structure or function, they all form aggregates via a crystallization-like process called nucleated or seeded
polymerization; moreover proteinaceous seeds grow by recruiting their soluble isoforms2,10,11. The efficiency to self-propagate varies in vivo,
depending on the intrinsic properties of the protein, which together with additional cellular factors such as molecular chaperones ultimately
determine rates of aggregate nucleation, seeding, fragmentation and spreading12-15. Hence, there must exist a fine balance among these
factors that allows efficient propagation of protein aggregation. This might also explain why only some amyloidogenic aggregates harbor the
characteristics of a prion, and thus not all PMDs are infectious. Prions seem to represent ‘top-performers’ of a wide spectrum of self-replicating
proteinaceous aggregates, which makes them a powerful tool to study PMDs8,13.

Intriguingly, the toxicity associated with disease-related aggregates often has a non cell autonomous component16,17. This means that they
affect neighboring cells that do not express the corresponding gene, in contrast to a strictly cell autonomous effect, which implies that only the
cells expressing the gene exhibit the specific phenotype. This was compellingly demonstrated by tissue-specific expression or knock down
of the respective proteins in numerous models of neurodegenerative diseases18-26. Various mechanisms have been suggested as a basis for
this non-cell autonomous toxicity in PMDs, including diminished nutrient supply, imbalance in neuronal signaling, glutamate excitotoxicity, and
neuroinflammation16,27,28. In addition, a prion-like movement of disease-linked aggregates between cells might contribute to this aspect29,30.
Increasing evidence suggests that protein inclusions other than prions can transmit from cell-to-cell, which may explain the characteristic
spreading of pathology observed in many PMDs30-36. However, it has yet to be determined whether there is a clear causal link between
intercellular movement of disease proteins and the toxic effect on neighboring cells. Therefore, a better understanding of the cellular pathways
that underlie cell-to-cell transmission and non cell autonomous toxicity is necessary and essential for the development of novel therapeutics.
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However, many aspects of prion-like spreading and cellular factors that influence cell-to-cell transmission of misfolded proteins in metazoans are
not well understood, in particular at the organismal level.

The nematode Caenorhabditis elegans has several advantages that provide the potential to discover new facets of prion-like spreading in
metazoans17. It is transparent, allowing for in vivo tracking of fluorescently tagged proteins in the living organism. Furthermore, many cellular and
physiological processes affected by disease are conserved from worms to human, and C. elegans is also amenable to a wide variety of genetic
manipulations and molecular and biochemical analyses37-39. Exactly 959 somatic cells make up the adult hermaphrodite with a simple body plan
that still has several distinct tissue types, including muscle, neurons and intestine.

To establish a new prion model in C. elegans, we chose to exogenously express the well characterized glutamine/asparagine (Q/N)-rich prion
domain NM of the cytosolic yeast prion protein Sup35, since there are no known endogenous prion proteins in worms4,40. Yeast prions have
been invaluable in elucidating basic mechanisms of prion replication41-44. Furthermore, NM is the first cytosolic prion-like protein that has been
shown to recapitulate the full life cycle of a prion in mammalian cell culture45,46. Likewise, when expressed in C. elegans, the Sup35 prion
domain adopted remarkably well to the different requirements for propagation in metazoan cells compared to yeast cells and exhibited key
features of prion biology40. NM aggregation was associated with a profound toxic phenotype, including the disruption of mitochondrial integrity
and appearance of various autophagy related vesicles on the cellular level, as well as embryonic and larval arrest, developmental delay, and
a widespread disturbance of the protein folding environment on the organismal level. Strikingly, the prion domain exhibits cell autonomous and
non cell autonomous toxicity, affecting neighboring tissues in which the transgene was not expressed. Furthermore, the vesicular transport of the
prion domain within and between cells is monitored real time in vivo40.

Here we describe how to examine prion-like dissemination in C. elegans. We will explain how to monitor the intra- and intercellular transport of
vesicles containing the prion domain using time-lapse fluorescence microscopy. We will emphasize the use of tissue-specific folding sensors
and ubiquitously expressed stress reporters to evaluate cell autonomous and non cell autonomous effects on cellular fitness. Finally, we will
describe the procedure of a recently performed genome wide RNA interference (RNAi) screen to identify new modifiers of prion-induced toxicity.
In combination, these methods can help to tease apart genetic pathways involved in the intercellular movement of proteins and their non cell
autonomous toxicity.

Protocol

1. Monitoring Transcellular Spreading of Prion-like Proteins By In Vivo Time-lapse Imaging

NOTE: Grow C. elegans wild-type (WT) (N2) and transgenic lines according to standard methods and carefully control the cultivation
temperature47.

1. Generate transgenic lines of C. elegans expressing the prion-like protein, tagged with monomeric red fluorescent protein (mRFP). Watch this
video that demonstrates how to use microinjection48. For further details and methods describing how to integrate these extrachromosomal
lines, see49.

2. Prepare synchronized populations by egg laying or bleaching according to standard methods50.
1. Synchronization by egg laying

1. Transfer 10 - 20 gravid adults on a plate and let them lay eggs for 1 - 2 hr. Remove adults from the plate and let the progeny
grow until the desired age.

2. Synchronization by bleaching
1. Collect an unsynchronized population of gravid adults and bleach them with alkaline hypochlorite solution (250 mM NaOH and

1:4 (v/v) dilution of commercial bleach in H2O). Wash the eggs twice (218 x g for 1 min) with M9 buffer47 (21 mMNa2HPO4·7H2O,
22 mMKH2PO4, 86 mMNaCl, 1 mMMgSO4·7H2O, add dH2O up to 1 L).

2. Allow them to hatch in M9 buffer with gentle agitation O/N at 20 °C. Worm development will arrest at the L1 stage in the absence
of a food source, leaving a synchronized population. Transfer L1s onto fresh Nematode Growth Media (NGM) plates seeded with
OP50 E. coli bacteria and let the progeny develop until the desired age47.

3. Prepare 2% agarose pads (in H2O) on a microscope slide as described50.
1. Prepare two microscope slides with labeling tape placed over their entire length to be used as spacers. Place a third microscope slide

between them.
2. Dissolve 2% agarose in H2O and pipette one drop onto the clean slide.
3. Place a fourth slide perpendicular to the three other slides on top of the agar drop. Gently press it down to flatten the pad to the same

thickness as the labeling tape.
4. Let it dry for 1 min before removing the spacers and gently pulling the slides apart. The agar pad will stick to one of them.

4. Pipette ~10 µl anesthetic (2 mM levamisole in M9 buffer) to the pad and transfer ~10 animals using a platinum wire pick. Cover with a cover
slip (~22 x 22 mm) and take images within 1 hr.

5. Alternatively, to acquire movies over a longer period of time or to further reduce the possibility of any movement of the animals, use a
combination of anesthetic and bead immobilization51.

1. Prepare 10% agarose pads (in M9 buffer) as described51 and add worms to 3 µl nanosphere size standards solution (polystyrene
beads, 100 nm) plus 3 µl anesthetic (4 mM levamisole in M9 buffer). Cover gently with a cover slip. To avoid desiccation, seal the cover
slip with VALAP (mixture of equal amounts of Vaseline, lanolin, and paraffin wax).

6. Image immobilized worms using a confocal microscope.
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NOTE: Results are obtained using a Spinning Disc AF Confocal Microscope equipped with an EM-CCD camera and a Microscopy
Automation & Image Analysis Software such as MetaMorph and outline the specifics below, but other comparable confocal imaging systems
can also be used.

1. Use the 63X or 100X/1.4NA oil objective and place the microscope slide containing worms into the microscope slide holder.
2. Open the software. Adjust laser power and filters for mRFP imaging. Use the 561 nm laser at 10% power and emission filter >600 nm.
3. Open “MultiDimensional Acquisition”. Under the “Main” tab, check the boxes for “Timelapse” and “Run Journals” (Hardware Auto

Focus: off).
4. Under the “Saving” tab select or create the directory folder where the files should be saved. Assign a name to the file.
5. Under the “Wave Length” tab select the appropriate illumination and adjust exposure and gain. Use “YokoQuad Red” (or an equivalent

illumination setting for mRFP imaging) with an exposure between 100 and 300 msec and a camera gain between 100 and 300,
depending on the individual sample (assessed by using the live image).

6. Under the “Timelapse” tab select “Number of time points” = 301, “Duration” = 5 min and “Time/Interval” = 1 sec.
7. Under the “Journals” tab select Journal: “AFC SET Z HOLD” and “AFC Return to Z HOLD”, Type: “Special” (twice), Initial Point: “Start

of time point” and “End of time point”. This autofocus option is important to image the same section over a longer period of time.
8. When the setup is done, press “Acquire”. The timelapse video is safed as separate TIFF files.
9. Open all .tiff files of a given time series in ImageJ. Go to “Image” →“Stacks”→“Images to Stacks”. Optionally, adjust brightness and

contrast, add size bar, etc. Export the movie under “File”→“Save as”→“AVI…” (for an example, see Video 1 and 2 corresponding to
Figure 1).

2. Using Folding Sensors and Stress Reporters to Investigate Cell Autonomous and Non
cell Autonomous Affects on Proteostasis and Toxicity

1. Generate transgenic lines that coexpress a folding sensor or stress reporter together with the prion-like protein. For methods on how to
establish crosses or generate transgenic lines, see48,49,52. See Table 1 for a list of C. elegans strains that can be used.

2. Prepare synchronized populations of transgenic animals and grow them until the desired age as described above (section 1.2)50.
3. Using a stereomicroscope, examine the respective phenotype of the folding sensor or stress reporter.

1. For the folding sensor, determine the number of animals harboring aggregates on each day after synchronization (for an example, see
Figure 2E and F).

2. For the stress reporter, test if the coexpression of the prion-like protein results in an increased fluorescence of the reporter (for an
example, see Figure 3).
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3. Genome-wide Screen for Suppression of Prion-induced Toxicity in C. elegans

 

Figure 4. Schematic representation of the RNAi screening protocol. See protocol section 3 for a detailed description of the individual steps.

1. Synchronization of C. elegans worms and duplication of RNAi library
1. For the RNAi screen, use the Ahringer RNAi library (or the Vidal RNAi library)53,54. Rearray the RNAi library from the original 384 well

format into 96 well plates by filling the plates with 100 µl LB-amp media (50 μg/ml Ampicillin in LB) supplemented with 10% glycerol
and inoculate using a 96-pin replicator. Grow at 37 °C O/N with agitation and store at -80 °C.

2. Maintain C. elegans WT and transgenic lines at 20 °C on NGM plates seeded with OP50 E. coli bacteria according to standard
methods47.

3. Synchronize prion domain transgenic and WT (control) nematodes by bleaching (see section 1.2).
4. On the same day that the worms are bleached, prepare LB media supplemented with 50 μg/ml ampicillin. Use an automated reagent

dispenser to dispense (or pipette manually) 65 μl of the LB-amp media into each well of a 96 well plate.
5. Remove 96 well Ahringer RNAi library plates from -80 °C and bring them to a sterile hood lined with paper towels. Immediately remove

the seal-tape by holding the plate upside down while plates are still frozen, being careful to avoid contamination from ice on the outside
of the plates. Reinvert the plates and let them thaw for about 30 min.
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6. Dip one sterile 96 pin replicator into one RNAi library plate, and then into one fresh LB-amp plate. Use a fresh sterile replicator for each
plate. Seal all plates with adhesive foil tape and return the library plates to -80 °C. The replicators can be soaked in bleach, rinsed, and
autoclaved to be used again.

7. Allow duplicated RNAi plates to grow O/N in an incubator set to 37 °C and 300 rpm. To use HT115 E. coli bacteria harboring the empty
vector (L4440) as a control, grow it separately in a culture tube and then pipette 65 μl of the culture with a multichannel pipette into one
quarter of two 96 well plates.

2. Induction of bacterial dsRNA production and addition of worms
1. Dilute Isopropyl-β-D-thiogalactopyranosid (IPTG) to a 5 mM concentration in ddH2O. Use an automated workstation with a multichannel

head to dispense (or pipet manually) 10 μl of diluted IPTG into each well of the RNAi bacteria and the control plates. Reseal and place
the plates back into the incubator. Let them shake for 3 hr at 37 °C.

2. While bacteria are shaking, prepare the worms. Mix the M9/worm suspension well, and pipette a small sample (~5 - 10 µl) to a glass
microscope slide. Count the number of worms under a stereomicroscope and calculate the number of worms per μl.

3. Using sterile technique, prepare a solution of supplemented M9 (M9+) with the following final concentrations: 0.20 mg/ml IPTG, 8.0 μg/
ml Cholesterol, 50 μg/ml Ampicillin, 9.6 μg/ml Tetracycline, 0.0835 μg/ml Fungizone, and 15 worms per 50 μl.

1. Make separate solutions for prion domain transgenic and WT worms. The final volume of M9+ worm solution needed will depend
on the number of RNAi plates copied (see below), plus ~30 ml of dead volume that will remain in the reservoir, if an automated
dispenser is used.

4. After the 3 hr induction of bacterial dsRNA production, take the plates out of the incubator and let them cool to RT (~30 min) to avoid
heat stressing the animals.

5. Dispense 50 μl M9+ prion domain transgenic worm solution to each well of the RNAi plates and one of the empty vector control plates.
Make sure to mix the worm solution before each step as the animals tend to sediment to the bottom of the reservoir.

6. Dispense WT worms into the second control plate. Leave the plates unsealed to allow aeration. To keep the liquid culture from
evaporating, stack 4 - 5 plates together and wrap with a damp paper towel and aluminum foil. Incubate at 200 rpm at 20 °C for 4 days.

3. Scoring
 

NOTE: After 4 days in the incubator, the worms will be at the second day of adulthood and are ready to screen. Let the animals adjust to non
shaking conditions for 30 min before screening to ensure undisturbed thrashing.

1. Using a Falcon 4M60 camera connected to a computer with a monitor, screen visually for increased thrashing as compared with control
treated prion domain transgenic animals.

2. Compile a list of preliminary hits to confirm using wrMTrck (see next section).

4. Confirmation of Preliminary Screen Hits

1. Motility assay on solid plates
1. Prepare plates with NGM supplemented with 100 µg/ml ampicillin, 12.5 µg/ml tetracycline and 1 mM IPTG, according to standard

methods47. If possible, use a plate-pouring machine to assure all plates have the same height of media, which will allow for a more
streamlined video acquisition process.

2. Grow the different RNAi clones in ~1 ml LB + 50 µg/ml ampicillin, O/N at 37 °C and 250 rpm.
3. The next day, induce the expression of the dsRNA with 1 mM IPTG for 3 hr. Seed the plates with 150 µl of each RNAi bacterial clone,

spread into a thin layer. Let the bacteria dry for 2 days at RT in the dark. Prepare 3 plates per RNAi clone.
4. Synchronize the worm population by bleaching according to standard methods50 (see section 1.2), and let the eggs hatch O/N in M9

media.
5. Take a sample of the worm suspension and determine the amount of nematodes per µl at the stereomicroscope. Then, pipette the

proper volume of M9 plus worms into each experimental plate so that it contains 25 - 30 L1 worms. Grow the nematodes at 20 °C for 4
days until the worms reach day 2 of adulthood.

2. Quantitative analysis of worm motility with the wrMTrck plugin for ImageJ
 

NOTE: The videos were recorded using a stereomicroscope at 10X magnification with a Hamamatsu Orca-R2 digital camera C10600-10B
and the Hamamatsu Simple PCI imaging software.

1. Turn on the camera and the Simple PCI imaging software. Click on “Live” to allow for adjustment of the imaging conditions.
2. Set up the video conditions as follows: Gain = 0; Light Mode = High; Speed Index = 1; Binning = 2. Click “Auto Expose” and then adjust

the lighting conditions, moving the microscope mirrors and the brightness and contrast dials.
 

NOTE: The video needs to have a high contrast without being overexposed, so that the animals appear as black shapes on a bright
background.

3. Click on “Time Scan” and choose a folder and a file name. Set “Field Delay” to 20 msec and “Stop at Time” to 30 sec. Press “Live
Review” in order to choose the area of the plate to record (where most worms are). Tap the plate 3 or 4 times on the stage, quickly
confirm its position in the field of view and press “Start”.

4. After the movie finishes recording, right click on the image and choose “Export Montage Sequence” to export the movie from a .cxd
format to an .avi.

3. Analyzing the motility videos
1. Open the ImageJ software, go to the “Plugins” tab, then “wrmtrck” and select “wrMTrck Batch”. Select the directory containing all the

files to be analyzed.
2. In the main input window of wrMTrck_Batch, load the input values as detailed in Figure 5C. Explanation for each of the parameters can

be found in the instructions that accompany the plugin. Click “OK” and let the movement analysis run.
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3. To curate the results and confirm that all detected tracks are from actual C. elegans and eliminate artifacts, open each of the .txt files
created for each movie and copy the information to a data analysis software file. Open the “*_labels.zip” files created and run the
resulting “*_labels.tif” to manually check and eliminate false worm tracks.

Representative Results

Monitoring intercellular spreading of prion-like proteins by in vivo time-lapse imaging

Transgenic C. elegans lines expressing the prion domain are particularly well suited for the analysis of certain aspects of prion-like proteins, e.g.,
cell-to-cell transmission and non cell autonomous toxicity. The transparency of the animals enables tracking of fluorescently tagged proteins
from within the living organism at every stage of life. Taking advantage of this, movement of prion-like proteins across cells and tissues using a
fluorescence microscope are visualized. A 63X or 100X/1.4NA oil objective is necessary to resolve the vesicular structures. Importantly, the prion
domain has to be tagged with mRFP, in order to remain fluorescently visible within these presumably acidic vesicles40. Yellow fluorescent protein
(YFP), which is often used as a tag, is not suitable because it is quenched in a low pH environment40,55. Strain AM815 expresses RFP-tagged
R2E2 (a highly aggregation-prone and toxic form of the prion domain NM) that accumulates in tubular vesicles, while the RFP tag alone remains
soluble (Figure 1A and B). Using in vivo time-lapse imaging, it could be observed that these tubular vesicles are transported within and between
cells40 (Figure 1C and D, Video 1 and 2) [place links to Video 1 and 2 here].

Using folding sensors and stress reporters to investigate cell autonomous and non-cell autonomous effects on proteostasis and
toxicity

Prions are able to cross seed related proteins and disrupt the cellular protein folding environment. This can be revealed through the
coexpression of appropriate folding sensors. Folding sensors are non-essential metastable proteins that depend on a functional proteostasis
network to fold correctly. Some examples are the well-known firefly luciferase and proteins harboring temperature-sensitive (ts) mutations56-66.
A disruption of proteostasis leads to misfolding of the reporter, which can be detected by visual examination of aggregates or by exposure of
the respective ts mutant phenotype at permissive temperatures. Stretches of polyglutamine (polyQ) with a length at the threshold of aggregation
(around 40 residues) are also often used because they exhibit an age-dependent aggregation67-69. Earlier onset of aggregation reveals a
compromised folding environment. Here, we employed a prion mutant RΔ2-5 that remains soluble when expressed in C. elegans body wall
muscle (BWM) cells and intestine40 (Figure 2A and C). Upon simultaneous expression with R2E2 in BWM cells, RΔ2-5 readily aggregates
(Figure 2B), revealing a cell autonomous effect of R2E2 on the protein folding environment. The widespread effect on proteostasis and
induction of misfolding across tissues can be evaluated by expression of the folding sensor in a distinct tissue that does not express the highly
aggregation-prone form of the prion domain. R2E2 was expressed under a BWM cell specific promoter (myo-3p), whereas RΔ2-5 was expressed
under an intestine-specific promoter (vha-6p). Aggregation of intestinal RΔ2-5 demonstrates that R2E2 affects protein folding in a non cell
autonomous manner40 (Figure 2D). Instead of using RΔ2-5, where aggregates can only be detected at high resolution, the use of polyQ44
expressed in the intestine (Q44i) allows visualization of aggregates at low resolution under a stereomicroscope (Figure 2E and F). Furthermore,
this enables a quantification of animals with aggregates, as well as a quantification of the number of aggregates.

To investigate non cell autonomous toxicity of the prion domain, we previously examined neighboring tissues that do not express R2E2 by
electron microscopy and found that expression of the prion domain in muscle cells leads to a non cell autonomous disruption of mitochondrial
integrity in adjacent tissues, such as the intestine40. Mitochondrial dysfunction results in increased reactive oxygen species (ROS) production
and oxidative stress. A noninvasive way to visualize induction of the oxidative stress response is to use an oxidative stress inducible reporter70.
The strain CF1553 expresses green fluorescent protein (GFP) under the oxidative stress inducible promoter sod-370. When crossed to animals
expressing the prion domain R2E2 in BWM cells, the reporter was significantly upregulated in BWM cells as well as in numerous non-BWM
tissues (Figure 3). This strain can be used to examine if certain candidate genes influence this non cell autonomous induction of the oxidative
stress response. Table 1 provides a list of C. elegans strains expressing folding sensors and stress reporters that can be used analogously.

Genome-wide screen for suppression of prion-induced toxicity in C. elegans

The complex toxicity phenotype of the prion domain expressed in C. elegans is particularly interesting because of the lack of discernible
toxicity observed in most in vitro prion models71. This model might reveal new pathways that can influence the toxicity associated with prions
in metazoans. To address this, we have screened for genes that, when RNAi-depleted, would improve the motility defect of R2E2 transgenic
animals. Control treated WT worms can be used as a positive control, although most candidate genes will not provide a full movement
phenotype rescue, due to the variable RNAi penetrance and the high toxicity of the transgene. The animals were treated for 4 days with RNAi,
from the first larval state L1 to day 2 of adulthood. By that time, the thrashing of untreated R2E2 animals is significantly slower than the thrashing
of WT animals, which is important because we are screening for an improvement of motility. F1 progeny will be present (~L1s), but is easy
to distinguish from the P0 generation. Only the P0 generation is scored. This initial screen is visual and non quantitative and therefore, a
low threshold was used to identify preliminary hits, meaning that every bacterial RNAi clone that seemed to increase the thrashing of prion-
expressing animals was retested in a quantitative crawling assay. Figure 4 outlines the main steps of the screen setup. The high resolution of
the Falcon 4M60 camera enabled a visual screening of a quarter of the plate at a time on a computer screen, which allowed the screen to be
completed more efficiently. While helpful, this is not necessary. The visual examination of worm thrashing can also be performed by using a
stereoscope at low magnification (10X).

Confirmation of preliminary screen hits

High throughput screens are performed as an approach that allows analyzing genome wide effects to obtain a primary list of candidate genes
that can be refined by complementary methods. Validation of the screen results is therefore essential to eliminate possible false positives, which
might result from performing a screen with only one experimental sample per RNAi. R2E2 transgenic animals were fed with the RNAi clones
of primary hits and measured their speed on NGM plates on the second day of adulthood, as a quantifiable readout of motility and decreased
toxicity. We used the wrMTrck plugin for ImageJ, developed in our laboratory, which accurately identifies C. elegans in videos and follows their
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movement. The wrMTrck plugin and scripts for automated analysis are open-source and publicly available at http://www.phage.dk/plugins/
wrmtrck.html, along with detailed instructions on how to use it. After downloading, copy the whole wrMTrck folder to the Plugins folder of ImageJ.
This protocol describes the wrMTrck_Batch method, preferred for analyzing a large number of videos at a time, but instructions for a manual,
movie by movie, analysis are also available with the plugin download. WrMTrck_Batch converts an original video (Figure 5A) into a binary
format with background subtraction and each worm is assigned a track. Each of the processed videos can later be viewed with these tracks
superimposed, in order to manually eliminate any artifacts that were falsely identified as worms (e. g., track 1 in Figure 5B). One effective way
to eliminate background artifacts (indicated with an arrow on Figure 5B) is to carefully choose the minimum and maximum size of the objects
to be identified (Figure 5C). From the different outputs of the wrMTrck plugin, we use the body lengths per second (BLPS) parameter which
measures the average speed of each animal, represented by the length of each track divided by the body length of each object, thus normalizing
for potential differences in size of the nematodes (Figure 5D). Using this method, we identified 35 suppressors of prion-induced toxicity (sopt)
that increased the motility phenotype in R2E2 expressing C. elegans to at least 133% and up to 256% when compared to empty vector-treated
worms (Figure 6). These sopt genes represent the final confirmed hits that resulted from our high throughput screening efforts.

 

Figure 1. The prion domain spreads between cells and tissues in C. elegans by vesicular transport. (A) Collapsed confocal z-stacks of
nematodes expressing RFP in body wall muscle (BWM) cells (RFPm). (B) Collapsed confocal z-stacks of nematodes expressing the highly
toxic and aggregation prone NM variant, R2E2, in BWM cells (R2E2m). Arrows indicate tubular vesicles, arrowhead indicates aggregate. (C
+D) Time-lapse series of animals expressing RFPm (C) and R2E2m (D). Arrows indicate areas of vesicular movement. RFPm exhibits mostly a
diffuse staining. Even when RFPm is found in vesicles, these barely move. R2E2m localizes to numerous vesicles that are transported within and
between cells. Scale bars: 10 µm. The accompanying Videos 1 and 2 [place links to Video 1 and 2 here] correspond to the Figures 1C and D,
respectively.
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Figure 2. Folding sensors reveal the widespread effect of the prion domain on proteostasis. (A+B) Coexpression of R2E2m promotes
RΔ2-5m aggregation. Confocal images of (A) RΔ2-5m control and (B) RΔ2-5m coexpressed with R2E2m in BWM cells. (C+D) Muscle expressed
R2E2m promotes intestinal RΔ2-5i aggregation. (C) Confocal image of control animal expressing RΔ2-5i in intestinal cells. (D) Confocal image
of animals expressing R2E2m in BWM cells and RΔ2-5i in the intestine. Scale bars: 10 µm. (E+F) R2E2m induces non cell autonomous
aggregation of Q44i. (E) Representative fluorescent images of Q44i and Q44i;R2E2m animals 4 days after transferring synchronized L1 larvae
onto fresh OP50-seeded NGM plates. The expression of R2E2 in BWM cells leads to an earlier onset of Q44i aggregation in the intestine. (F)
Quantification of animals with aggregates (in %) on indicated days after synchronization. Error bars represent S.D. This figure has been modified
from40.

 

Figure 3. The sod-3p::GFP transcriptional stress reporter reveals that the prion domain causes cell autonomous and non cell
autonomous induction of oxidative stress. (A+B) Representative fluorescent images (using the same exposure time) of sod-3p::GFP
expressing control animals (A) and sod-3p::GFP;R2E2m animals (B) on day 2 of adulthood. (C) The expression of R2E2 in BWM cells leads to
an induction of the reporter not only in BWM cells (I), but also in the intestine (II), nerve cord (III), pharynx and head neurons (IV).
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Figure 5. Analysis of worm movement with the wrMTrck plugin for ImageJ. (A) Example of an input movie generated by using an
appropriate magnification (~10X) to monitor several animals at a time. (B) “*_labels.tif” files are an output of wrMTrck_Batch and allow for manual
curation of analysis results. Arrow indicates an object that was correctly excluded from the analysis due to an appropriate choice of minimum
and maximum size parameters. (C) Input window of wrMTrck_Batch, showing parameters used for this protocol. These parameters need to be
adjusted according to the individual microscope and movie settings. (D) Output results from movement analysis of (B), with the BLPS column
highlighted in yellow. Please click here to view a larger version of this figure.

http://www.jove.com
http://www.jove.com
http://www.jove.com
https://www.jove.com/files/ftp_upload/52321/52321fig5large.jpg


Journal of Visualized Experiments www.jove.com

Copyright © 2015  Journal of Visualized Experiments January 2015 |  95  | e52321 | Page 10 of 15

 

Figure 6. R2E2 worms treated with RNAi clones that are supressors of prion-induced toxicity (sopt) show improved motility. Motility
is shown as relative BLPS when compared to the negative control (empty vector). Shown are all statistically significant (student t-test) RNAi
clones identified in the HTP screen.  represents the hit shown as an example in Figure 5. Results are from 3 movies, with 17 <n <53 tracks per
condition. Error bars represent SEM.

Table 1. C. elegans strains expressing folding sensors and stress reporters.

Strain name genotype Comments Strain source

Folding sensors

transgenes

AM140 unc-54p::polyQ35::yfp muscle-specific expression
of polyQ35, age dependent
aggregation

CGC or Morimoto lab

AM141 unc-54p::polyQ40::yfp muscle-specific expression
of polyQ40, age dependent
aggregation

CGC or Morimoto lab

AM801 unc-54p::RΔ2-5::yfp muscle-specific expression of
nucleation incompetent prion
domain

Morimoto lab

OG412 vha-6p::polyQ44::yfp intestine-specific expression
of polyQ44, age dependent
aggregation

CGC

AM809 vha-6p::RΔ2-5::gfp;     
myo-2p::mcherry

intestine-specific expression of
nucleation incompetent prion
domain

Morimoto lab

AM47 F25B3.3p::polyQ40::cfp neuron-specific expression
of polyQ40, cell type specific
aggregation

Morimoto lab

AM982 unc54p::luciferase::yfp muscle-specific expression of WT
firefly luciferase

Morimoto lab

myo-3p::luciferase::gfp; rol-6 muscle-specific expression of WT
firefly luciferase

Behl lab

sng-1p::luciferase::gfp; rol-6 muscle-specific expression of WT
firefly luciferase

Behl lab

FUH55 unc54p::FLUC::egfp; rol-6 muscle-specific expression of WT
firefly luciferase

Hartl lab

FUH134 unc54p::FLUCSM::egfp; rol-6 muscle-specific expression of
R188Q mutant firefly luciferase

Hartl lab
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FUH135 unc54p::FLUCDM::egfp; rol-6 muscle-specific expression of
R188Q+R261Q double mutant
firefly luciferase

Hartl lab

FUH48 F25B3.3p::FLUC::egfp; rol-6 neuron-specific expression of WT
firefly luciferase

Hartl lab

FUH136 F25B3.3p::FLUCSM::egfp; rol-6 neuron-specific expression of
R188Q mutant firefly luciferase

Hartl lab

FUH137 F25B3.3p::FLUCDM::egfp; rol-6 neuron-specific expression of
R188Q+R261Q double mutant
firefly luciferase

Hartl lab

ts mutants

CB1402 unc-15(e1402) I Paramyosin(ts), temperature
sensitive Unc-paralyzed, Let

CGC

CB1157 unc-54(e1157) I Myosin(ts), temperature sensitive
Unc

CGC

CB1301 unc-54(e1301) I Myosin(ts), temperature sensitive
Unc

CGC

CB286 unc-45(e286) III Unc-45(ts), temperature sensitive,
slow moving Unc, Egl

CGC

HE250 unc-52(e669su250) II Perlecan(ts), temperature sensitive
Unc, stiff paralysis

CGC

SD551 let-60(ga89) IV Ras(ts), temperature sensitive Muv,
Ste, Let, Lva, Osm

CGC

CX51 dyn-1(ky51) X Dynamin(ts), temperature sensitive
Unc

CGC

CW152 gas-1(fc21) X Gas-1(ts), temperature sensitive
EtOH sensitivity

CGC

ZZ26 unc-63(x26) I Acetylcholine receptor(ts),
temperature sensitive levamisole
resistance

CGC

stress reporters

CL2070 hsp-16.2p::gfp;rol-6 thermal stress; UPRcyto CGC

TJ375 hsp-16.2p::gfp thermal stress; UPRcyto CGC

TJ3000, TJ3001 hsp-16.2p::gfp;                       Cbr-
unc-119(+)

thermal stress; UPRcyto CGC

AM446 hsp70p::gfp;rol-6 thermal stress; UPRcyto Morimoto lab

AM722 hsp70p::mcherry; myo-2p::cfp thermal stress; UPRcyto Morimoto lab

AM799 hsp90p::gfp thermal stress; UPRcyto Morimoto lab

OG497 hsf-1p::hsf-1::gfp; Cbr-unc-119(+) thermal stress; UPRcyto CGC

CF1553 sod-3p::gfp;rol-6 oxidative stress CGC

KN259 sod-3p::gfp;rol-6 oxidative stress CGC

CL2166 gst-4p::gfp::nls oxidative stress CGC

LD1171 gcs-1p::gfp;rol-6 oxidative stress CGC

LD1 skn-1p::skn-1::gfp;rol-6 oxidative stress CGC

IG274 nlp-29p::gfp osmotic stress CGC

BC20309 mtl-1p::gfp metal stress Baillie lab

BC20342 mtl-2p::gfp metal stress Baillie lab

BC20314 elt-2p::gfp metal stress Baillie lab

SJ4005 hsp-4p::gfp UPRER CGC

SJ4100 hsp-6p::gfp UPRmito CGC
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SJ4058 hsp-60p::gfp UPRmito CGC

CGC: Caenorhabditis Genetics Center; ts = temperature sensitive; UPR = unfolded protein response; cyto = cytosolic; mito = mitochondrial; ER =
endoplasmic reticulum.

Discussion

The methods described here help to illustrate spreading and the complex cell autonomous and non cell autonomous toxicity of prion-like
proteins. We recently discovered that an aggregation-prone cytosolic prion domain is taken up into membrane-bound vesicles in an autophagy
related process. A specific subset of these vesicles transports the prion domain within and between cells and tissues40. The key to monitor
their movement in the living animal is that the protein has to be tagged with mRFP, because only mRFP-tagged proteins were visible in these
presumably acidic vesicles. Using the same approach, we are currently investigating the potential prion-like behavior of certain disease-related
proteins, such as superoxide dismutase 1 (SOD1) (linked to ALS), alpha-synuclein (linked to PD) or TAR DNA-binding protein 43 (TDP-43)
(linked to ALS). Although this intercellular transport within vesicles seems to be used by several other proteins, there might be additional
pathways that allow spreading.

The use of well characterized folding sensors is a powerful tool to monitor effects on the cellular protein folding environment in C. elegans63-66.
Here we have shown how to use the age dependent accumulation of fluorescently tagged aggregation prone proteins expressed under
tissue-specific promoters to visually monitor the folding capacity of distinct tissues simultaneously. Other possibilities to study the organismal
proteostasis network include the use of endogenous ts mutant proteins. These metastable proteins will function normally at the permissive
temperature (15 °C), but misfold and become nonfunctional at the restrictive temperature (25 °C), exhibiting their characteristic mutant
phenotype. In the presence of an aggregation prone protein or during aging, the ts mutant phenotype gets exposed even at permissive
conditions63-66. Some of these ts mutants are expressed in only a subset of tissues or exhibit tissue-specific phenotypes, making these
particularly useful to test for cell autonomous and non cell autonomous proteotoxic effects. For example, a ts mutant of LET-60, a member of
the GTP-binding RAS protooncogene family, Ras(ts), is ubiquitously expressed, but shows tissue-specific mutant phenotypes63,66. By using this
ts mutant, the effect of polyQ expansions on the cellular proteostasis was shown to be cell autonomous63. Expression of polyQ in the genetic
background of ras(ts) revealed only the mutant phenotype specific to the tissue in which the protein was expressed. The exposure of multiple
mutant phenotypes would indicate that a protein has non-cell autonomous proteotoxic effects.

Additionally, to test for effects on cellular stress pathways, there is a large selection of in vivo fluorescent stress reporters in C. elegans72. These
are usually transcriptional reporters that express green fluorescent protein (GFP) under a stress-inducible promoter, such as hsp-16.2p or
sod-3p, which report on thermal or oxidative stress, respectively72. By using appropriate reporters in combination with prion-like proteins, one can
monitor a potential induction of stress responses in tissues other than the one expressing the respective transgene. One caveat, however, is that
these stress reporters are often not sensitive enough to reveal subtle upregulation of a given pathway (unpublished observations).

On our quest to examine whether genes that influence the non-cell autonomous toxicity also affect protein spreading, we started by screening for
genes that, when knocked down, would ameliorate movement defects. Using visual evaluation of swimming rates as a read-out, we were able to
comfortably assay ~25 plates per session and perform two rounds of this protocol per week, resulting in the completion of the initial screen within
6 weeks. The confirmation of the hits, by quantitative analysis of worm movement on solid plates, in triplicates, using wrMTrck was performed
in an additional 3 weeks. One caveat, however, is that by using crawling in plates instead of swimming in liquid media as a read-out one might
lose certain candidate genes, as swimming and crawling are not identical motions and can be influenced by distinct pathways73. Thus, if some
candidate genes cannot be confirmed on solid plates, they should be re-tested in liquid media, where swimming can be quantified by counting
the thrashing frequency within a given time.

The screening protocol described here uses automated liquid handling workstations, which greatly reduces variability. The disadvantage is that
an excess of fluids for the reservoir of the robots is needed, which might not always be feasible. This screening setup can be easily adapted for
other screens in C. elegans that use thrashing as a read-out.This screen was not designed to directly identify genes that influence the spreading
or non cell autonomous toxicity of the prion domain, as genome wide screens should be simple in design, so as to be performed in a timely
manner. Motility defects can originate not only from muscular, but also from neuronal damage and from a number of other gene defects53. Thus,
by using this readout, we might find not only modifiers of muscle-specific toxicity. We are currently testing the candidate genes for their effects on
prion domain spreading and non cell autonomous toxicity using the methods described above. These experiments will eventually reveal whether
transcellular spreading of protein aggregates is directly linked to the toxicity observed in other tissues or if cell-to-cell transmission and non cell
autonomous toxicity can be uncoupled.

Taken together, the described methods can be used to examine the potential prion-like behavior of proteins at the cellular and organismal level
using C. elegans.
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